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1. INTRODUCTION 

Control central with connection to IP network. 

Supports the broadcast of announcements and music through an IP network, via streaming, in addition to 
control data and equipment configuration. 

Principal characteristics: 

 Digital audio and control data via an IP 
connection (UDP/IP Multicast). 

 Double Ethernet connection for installations 

with redundant network systems. 

 Operation in stand-alone mode or with P.A. 
Manager control software. 

 Surveillance of equipment operation by means 

of P.A. Manager software and/or basic TELNET 
functions. 

 IP address configuration: 

o By means of a DIP switch, facilitating the 
replacement of equipment in an 

installation. 

o By means of the desk configuration menus. 

o In flash memory, through software. 

 Constant (IP) notification of the equipment 
status by means of Heart beat. 

 Volume control of digital amplifiers. 

 Pre-recorded messages resident in the desk, 
located in: 

o Flash memory (remotely updateable by 
IP). 

o MP3 memory, locally updateable through 

USB connection. 

 Display of system alarms.  

 Display of zone status. 

 Critical path surveillance (from capsule). 

 Internal status surveillance. 

 Primary and secondary power supply 
surveillance. 

 Dispatch of announcements to zones and/or 

groups. 

 Activation of pre-recorded general purpose 
messages. 

 Key for repetition of the last live voice 

message. 

 Special features as an emergency desk, with 
broadcast of live voice messages, evacuation 

and warning message. 

 Warning and evacuation message activation 

buttons. 

 Distinct work modes: Zone Selection Mode 
and Emergency Mode. 

 Activation of emergency mode: 

o By activation of a contact. 

o Via password protected keypad. 

o By pressing the Evacuation or Warning    
button (configurable). 

 Announcements with or without a pre-
announcement tone (Gong). 

 Customizable gong. 

 Supports the connection of a music source, 
sending the music program via IP. 

 Alarm LED indicator. 

 Configurable input contacts (emergency mode 

/ announcement mode).   

 Monitor loudspeaker. 
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2. FRONT VIEW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Microphone 

(2) WARNING button 

Pre-evacuation announcement activation key. 

Functionality: 

a) In emergency mode, it sends the message 
assigned to the button to the emergency 

group. 

b) In button emergency mode, it goes into 
emergency mode and sends the message 

assigned to the button to the emergency 
group. 

c) In zone selection mode, it sends the message 

assigned to the button to the zone selected. 

 

(3) EVACUATION button 

Evacuation announcement activation key. 

Its functionality is the same as the Warning 
button, but it has priority over this button (when 
the EVACUATION button is activated, the 

assigned message is activated and it cuts off the 
WARNING message if this is being played). 

The messages assigned to the WARNING and 
EVACUATION buttons can be stored in the desks 

or in the power units of the OPTIMAX series. Both 
equipment units have two memories for storing 
messages: flash memory (WAV) and MP3 
memory.  

Depending on the configuration, the messages 
assigned can be the following: 
 

 Zone (amplifier) Desk 

Flash memory (WAV)  Message 1, 2 or 3 Message 1 or 2 

Memory (MP3) Message 1 or 2 Any MP3 

 

(4) MENU navigation keys and OK/CANCEL  

selection 

(5) Monitor loudspeaker 

This serves to monitor the MP3 messages and the 

music input of the desk itself. 

(6) Numeric keypad 

Figure 1 

 ATTENTION: WHEN CONNECTING THE CC-600ETH BOX TO THE IP 
NETWORK, ENSURE THAT THE CONNECTORS MARKED “TO SWITCH” ARE 
USED. IF THE CONNECTORS MARKED “TO OPTIMUS EQUIPMENT” ARE USED 
BY ERROR, THE SWITCH OR ROUTER IN THE INSTALLATION MAY BE 
DAMAGED.  
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(7) GONG+TALK key 

Used to send a live paging preceded by a GONG. 

First, select the zones to which the 
announcement is to be sent. Hold the key down 
while you speak. 

(8) TALK button 

Used to send a live voice announcement. First, 
select the zones to which the announcement is to 

be sent. Hold the key down while you speak. 

(9) REP key 

Key for repetition of the last live voice message 
sent. 

(10) PLAY key 

Used to send a pre-recorded message. First, 
select the message as well as the zones to which 

it is to be sent. 

(11) PLAY indicator 

Indicates that a pre-recorded message is being 

played. 

(12) TALK indicator 

When it lights, it indicates that you can begin to 
make the announcement. 

(13) GONG indicator 

When it lights, it indicates that the desk is 
generating the GONG. 

(14) BUSY indicator 

When it lights, it indicates that the system is 
busy. 

(15) EMERGENCY MODE indicator 

When it lights, it indicates that the desk is in 
emergency mode. 

(16) ALARM indicator 

Indicates an alarm. Software configurable. 

(17) POWER indicator 

Indicates that the desk is receiving power. 

(18) Display 

(19) MIC LEVEL indicator 

Indicates the audio level of the microphone, the 

MP3 messages and the music input of the desk. 
The LED marked Peak indicates that the signal is 
saturated. This LED should not light. 

(20) ETH A and B indicators 

LINK: When lit, it indicates connection to the 
network through the ETHERNET A or B inputs. 

ACT: When it blinks, it indicates that data is 
being sent or received through the ETHERNET A 
or B inputs. 

(21) Interconnection cables between the 

desk and the junction box. 

(22) POWER indicator 

Indicates that the interconnection box is 

receiving power. 

(23) POWER SUPPLY 1 input 

24 V DC input to power the desk. 

(24) POWER SUPPLY 2 input 

24 V DC input to power the desk. The power 
supply inputs have been doubled, so that if—on 
account of safety regulations—the installation so 

requires, two independent power supplies can be 
connected. 

(25) Connector A “To OPTIMUS 

Equipment” 

Connection A between the desk and the 
CC-600ETH connection box. 

(26) Connector B “To OPTIMUS 
Equipment” 

Connection B between the desk and the  
CC-600ETH connection box. 

(27) ETHERCON aerial connectors for 
connection to the IP network. 

(28) Connector B “To Ethernet Switch” 

Used, in a redundant network, as a secondary 

connection to the ETHERNET network. 

(29) Connector A “To Ethernet Switch” 

Used for connection of the desk to the IP 
network. 
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3. REAR VIEW 

(1) 24 V DC power supply input 

It can be used to power the desk 
without the CC-600ETH connection 

box. 

(2) I1, I2 and I3 

Configurable input contacts. 

(3) MESSAGE UPDATE connector 

USB connector. Through this 
connector, pre-recorded messages can 
be copied into the internal MP3 

memory of the desk, where up to 16 
Mb of audio files in MP3 format can be 
stored. 

(4) ETH B connector 

Used, in a redundant network, as a 
secondary connection to the IP 

network. 

(5) ETH A connector 

Used for connection of the desk to the 
IP network. 

(6) RCA connectors R and L  

They support the connection of a music source, sending the music program via IP. 

 

 

4. CONNECTIONS 

4.1. Standard connection 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Connection 
to the 

Ethernet 
switch 

Figure 3 

Figure 2 

 ATTENTION: WHEN CONNECTING THE CC-600ETH BOX 
TO THE IP NETWORK, ENSURE THAT THE CONNECTORS MARKED 
“TO SWITCH” ARE USED. IF THE CONNECTORS MARKED “TO 
OPTIMUS EQUIPMENT” ARE USED BY ERROR, THE SWITCH OR 
ROUTER IN THE INSTALLATION MAY BE DAMAGED.  
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4.2. Connection in installations with redundant Ethernet network and 

double power supply 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.3. Connection of a music source to the desk 
 

 

 

 

 

 

 

 

 

 

 

 

Connection 
to the 

Ethernet 
switch 

Music 
source 

Figure 4 

Figure 5 

 ATTENTION: WHEN CONNECTING THE CC-600ETH BOX 
TO THE IP NETWORK, ENSURE THAT THE CONNECTORS MARKED 
“TO SWITCH” ARE USED. IF THE CONNECTORS MARKED “TO 
OPTIMUS EQUIPMENT” ARE USED BY ERROR, THE SWITCH OR 
ROUTER IN THE INSTALLATION MAY BE DAMAGED  
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4.4. Connection of the input contacts 

The input contacts of the DC-600ETH have two different modes of operation: Emergency System Mode 

and Announcement System Mode. To define the mode of operation of the contacts, see section 7.2.2, 
number (10). 

In both cases, the connections are the same, although the functionality of the contacts varies. 

 

4.4.1. Connection of the input contacts in Emergency System Mode 

 Input CONTACT "I1": 

If this is connected to the ground contact, the desk goes into 

emergency mode and remains in this mode as long as the 
contact is activated. 

 Input CONTACT "I2": 

By connecting it to the ground contact, it is used to activate 
the warning message. 

If the desk is in selection by zones mode, it is necessary to 
select the zone or zones for which the message is intended 
by means of the numeric keypad on the desk and then to 

activate this contact. The warning message is repeated while 
the contact is activated. 

If the desk is in emergency mode, when this contact is 

activated, the warning message will be sent to the 
emergency group (by default to all the zones). The message 
is repeated while the contact is activated or until the 
emergency mode is cancelled. 

 Input CONTACT "I3": 

By connecting it to the ground contact, it is used to activate 
the evacuation message.  

If the desk is in selection by zones mode, it is necessary to 

select the zone or zones for which the message is intended by means of the numeric keypad on the desk 
and then to activate this contact. The evacuation message is repeated while the contact is activated. 

If the desk is in emergency mode, when this contact is activated, the evacuation message will be sent to 
the emergency group (by default to all the zones). The message is repeated while the contact is activated 

or until the emergency mode is cancelled. 

 

 

4.4.2. Connection of the input contacts in Announcement System Mode 

In this mode, the rear contacts function as if they were the GONG+TALK, TALK and REPEAT keys on the 

desk. 

Ideal for remote control of the desks when integrators are used. 

 Input CONTACT "I1": 

If this is connected to the ground contact, the REPEAT function is activated, in the same way as when the 
REP key on the desk is pressed. 

This functionality is activated by pressing for at least 500 ms. 

EMERGENCY SYSTEM 

 Figure 6 
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If you wish to stop the repetition of the message before it 
ends, activate contact I1 once again. 

Before activating the repeat function, it is necessary to select 
the destination zones and/or groups for the message. 

 Input CONTACT "I2”: 

If this is connected to the ground contact, the TALK function 

is activated, in the same way as when the TALK key is 
pressed on the desk keypad. 

This functionality remains active while the contact remains 

activated. 

Before activating the TALK function, it is necessary to select 
the destination zones and/or groups for the message. 

 Input CONTACT "I3": 

If this is connected to the ground contact, the GONG+TALK 

function is activated (Pre-announcement tone + Talk), in the 
same way as when the GONG+TALK key is pressed on the 
desk keypad. 

This functionality remains active while the contact remains 
activated. 

Before activating the GONG+TALK function, it is necessary to select the destination zones and/or groups 

for the message. 

 

 

4.5. Fitting the ETHERCON NE8MC connectors and compatibility with 
RJ45 

The desk has NE8MC model Ethercon connectors. Four 
are pre-fitted on the two interconnection cables 
between the desk and the CC-600ETH box and 
another two are supplied as accessories for the 

connection of the box with the switch. 

These connectors reinforce the connection and so it is 
highly recommended to fit them. 

The table to the right shows the RJ45 brands and 
models that are compatible with this connector. 

 

 

 

ANNOUNCEMENT SYSTEM MODE 

 
Figure 7 

RJ 45 CONNECTOR TYPE RJ PART No. 

HIROSE TM11 

NEXUS E5088-011021 

MOLEX 44915-0011 

MH CONNECTORS RJ45SRB-FS-R 

EFB 37541.3 

BOMAR 300068S 

CANFORD 46-606 

BLACK BOX FM731 

STEWART 943-SP-370808S 

EUCON MPS-88R30 

DRATHEX 

220.9026 

220.0210 

220.0200 

220.0201 

 

Figure 8 
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NB: The IP address can also be set by software (see 
section 8) or by the keypad (see section 11.4.10). If this 
action is taken, the desk IP ADDRESS DIP switches cease to 
be operative. 

IP address 

Figure 9 

5. SETTINGS AND CONFIGURATION 

Situated on the underside of the desk, these 
controls can be used to configure the IP address, 
the microphone volume, the volume of the 

monitor and the sensitivity of the analog input 
(rear RCA connectors). 

 

(1)  MIC. VOLUME 

Adjustment of the microphone gain. 

(2)  SPEAKER VOLUME 

Volume of the monitor loudspeaker. 

(3)  IP ADDRESS 

DIP switches to configure the IP address of the 
desk. This address identifies the equipment unit 

in the network, so each unit must have a unique 
IP address. 

 

 

 

 

 

An IP address is represented by means of a 32-
bit binary number. The IP addresses are 
expressed as decimal notation numbers: the 32 

bits of the address are divided into four octets 
(an octet is a group of 8 bits). In the desk, each 
octet is represented by A0 to A7 for the first 

octet, B0 to B7 for the second octet, C0 to C7 for 
the third octet, and D0 to D7 for the fourth octet.  

In an octet, each bit can have the value 0 (DIP 
switch OFF) or 1 (DIP switch ON). In order to 
obtain the decimal value of the octet, the decimal 

values of each bit that is in the ON position must 
be added up (1, 2, 4, 8, 16, 32, 64 and 128). 

Remove screws a and b indicated in Figure 9 to 

gain access to the DIP switches. This figure 
shows an example in which the IP address 
192.168.100.128 is configured. 

On the next page, Table I shows all the DIP 

switch combinations from 0 to 255. 

(4)  MP3 FIRMWARE UPDATE 

Firmware download connector for the MP3 circuit. 

Contact Optimus technical staff for its use. 
Remove screws c, d, e and f indicated in Figure 9 
to gain access to the connector. 

(5)  MODE CONFIG. 

Configuration DIP switch to enable the MP3 
firmware download. Contact Optimus technical 
staff for its use. Remove screws c, d, e and f 

indicated in Figure 9 to gain access to the DIP 
switch. 

(6)  ANALOG INPUT SENSITIVITY 

Internal jumper for configuration of the analog 
audio input sensitivity to either 0 dB or -20 dB. 
Remove screws c, d, e and f indicated in Figure 9 

to gain access to the jumper. 
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Table I. Configuration of the IP address. 
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6. PRE-RECORDED MESSAGES 

The desk has two internal memories in which files can be stored for subsequent use as pre-recorded 
messages: MP3 Circuit Memory and Coldfire Flash Memory. 

 

6.1. Pre-recorded messages resident in the MP3 circuit memory 

6.1.1. Characteristics 

Access/Updating of messages Through the USB connector on the rear panel, by means of a PC. 

Memory capacity 16 Mb 

Maximum number of messages 20 

File format  MP3 

 

 

6.1.2. Transfer of messages to the MP3 memory of the desk 

The files must be copied to the MP3 memory with a specific name format. Otherwise the messages 
cannot be played. 

 

 

 

 

 

 

 

 

The MP3 files must have the CRC protection activated (most recording programs support this option). 
This ensures constant surveillance of the integrity of messages 1 and 2 in the MP3 memory (files 0001… 
and 0002…). If there were to be any problem in these files, the desk displays and sends an alarm 
message through the Ethernet connection towards the different units in the installation that have the 

capacity to receive it (FC-600ETH, DC-600ETH, DVA-102ETH, UMX-02/0, control computer…). 

To transfer the MP3 files to the desk, connect the computer that contains the messages to the DC-
600ETH by means of the USB connector on the rear panel. Use the PC browser to copy the files to the 

MP3 memory of the desk, which will be shown as an additional disk unit. The files must be copied into the 
root directory of the unit; do not use folders. 

 

 
ATTENTION: Once the files have been copied to the desk, it is necessary to UPDATE the memory of the desk. To do so, follow the 
instructions in section 11.4.8. Updating the MP3 memory. 
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NB: The file transfer operations shown hereunder can be performed with version 2.6.3 and upwards of the Optimus Flasher 
software. 

. 

 

6.2. Pre-recorded messages resident in the flash memory of the 

Coldfire circuit (WAV) 

6.2.1. Characteristics 

Access/Updating of messages Remotely, by means of a PC, through the IP connection 

Memory capacity 6 Mb 

Maximum number of messages 2 messages (maximum size of 3 Mb/message) 

File format  

.WAV 

Sampling rate: 48000 Hz, 24000 Hz and 12000 Hz (mono) 

Sample size: 16 bits 

 

6.2.2. Transfer of messages to the Coldfire flash memory 

To transfer the WAV files to the flash memory, it is necessary to have a PC connected to the same IP 

network as the desk and to use the Optimax Flasher application. This application is supplied together 
with the P.A. Manager software. To install it, run the file Optimax Flasher x.x.exe which can be found 
in the folder 02_FIRMWARE of the installation CD and follow the instructions of the assistant. 

Once the software has been installed, proceed as follows: 

1. Start the Optimax 
Flasher application. 

2. Select the Advanced 
tab (1). 

3. Enter the IP address of 

the desk in the IP Host 
field (2). 

4. Select DC/FC600ETH 
from the Equipment 

Type drop-down menu 
(3). 

5. Tick the box 

corresponding to the 
message that you wish 
to transfer (4) and 

indicate the route and 
file that you wish to use. 
(Local Message 1 
corresponds to the 

EVACUATION message 

and Local Message 2 to 
the WARNING 

message). 

6. Press the button Start 
Update Process (5) to begin to transfer the files. 

7. Press OK when the process has been completed. 

8. Exit the application (File>Quit). 

(2) 

(1) 

(4) 

(3) 

(4) 

(5) 
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7. STARTING UP A DESK 

To start up a DC-600ETH, proceed as follows: 

1. By means of the P.A. Manager software, add the desk to the installation. Refer to section 7.1.  

2. Configure the parameters of the desk. Refer to section 7.2. 

3. Connect the unit to the installation structure. Refer to section 7.3. 

4. Configure the IP address and make the connections. Refer to section 7.4. 

5. Send configurations to the desk. Refer to section 7.5. 

 

If the desk is already configured, connect it and when it starts up, it will already be operative. 

a) If the installation has a Server PC, the desk will download the configuration variations from the Server 

PC in the installation.  

b) If the installation does not have a Server PC, on start-up the desk will use the configurations of its 
local memory. 

 

 

 

7.1. Configuration of the desk in the installation by means of the P.A. 

Manager software 

To configure the desk, it is necessary to have a PC connected to the network that has the SCF-01 or 
SCM-01 (P.A. Manager) software. 

1. If the software is the SCM-01, start the application, open the Options menu and select Installations 
(administrator user level is required). If the software is the SCF-01, start the application. 

NB: Prior to configuration of the desk parameters, it is necessary to have configured the parameters of the installation and the PA 
areas. 

2. From the installation screen, click on the PA area to which you wish to add the desk. 

3. Open the Add Equipment menu and select DC600ETH/FC600ETH. The desk configuration window 

appears. 

4. Refer to section 7.2. Desk configuration parameters. 
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7.2. Desk configuration parameters 

7.2.1. General tab 

(1) Name 

Enter a name to identify the 
equipment unit. Maximum of 50 

characters. 

(2) Priority source 

Click on the drop-down menu and 

assign one of the Priority type 
sound sources available to the 
desk. These sound sources are 
defined during the configuration of 

Modes and sound sources. 

Each sound source has a Mode or 
priority level assigned to it, and so 

the source selected will determine 
the priority of the desk with respect 
to the other audio signals in the 

installation when an announcement 
is sent (for more information, see 
the Optimax Installations 

Configuration Manual). 

(3) Program source 

Configure this option if you have a music source 
connected to the desk (through the RCA 

connectors on the rear panel). 

Click on the drop-down menu and assign one of 
the Program type sound sources available to the 

desk. These sound sources are defined during the 
configuration of Modes and sound sources. 

Each sound source has a Mode or priority level 
assigned to it, and so the source selected will 

determine the priority with which the desk is to 
send the music with respect to the other audio 
signals in the installation (for more information, 

see the Optimax Installations Configuration 
Manual). 

 IP DATA 

(4) IP Address 

Enter the IP address of the unit. This IP must be 
unique to the installation and it must coincide 
with the configuration of the DIP switches on the 

underside of the unit, or with the address 

configured through the Web connection (see 
section 8), or with the address configured 

through the keypad (see section 11.4.10). It 
must be a fixed IP address. 

(5) Netmask and  

(6) Gateway 

In installations that require this. Consult the 
network administrator of the installation. 

 MULTICAST DATA (see also page 19) 

(7) IP Multicast 

Default setting 239.5.5.5. Do not modify this field 

unless the installation topology makes it 
necessary. All the units with an IP connection in 
the installation must have the same IP multicast 

address. 

(8) Multicast port 

Default setting 5000. Do not modify this field 
unless the installation topology makes it 

necessary. All the units with an IP connection in 
the installation must have the same multicast 
port. 

(9) Send “Heart beat” every n seconds 

Frequency with which the unit sends a heart beat 
signal to the multicast group. This signal informs 

the other units with an IP connection in the 
installation that the desk is operating perfectly. 

(10) Local Manager and (11) Global 
Manager 

Defines whether the desk is to function as a 
priority manager of the Optimax system, either 

locally at PA Area level or globally for the 

installation, and establishes the priority of this 
management with respect to other equipment 
units (1 = maximum priority). It is not advisable 

to activate this management on the DC-600ETH 
desk (see Notes on Local and Global Co-
ordinators on page 20). 

 

(1) (2) 

(3) 

(4) 

(5) 

(6) 

(7) 

(8) 

(9) 

(10) (11) 
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a) Information about the multicast configuration on Optimax equipments 
 
It is possible to modify the multicast configuration of all the equipment units in the installation simultaneously.  Proceed as follows: 

 

1. From the installation screen, 
open the Options menu and 
select Multicast Configuration. 

 

 

 

 

 

 

2. A window with the 
configurations of the multicast 
group appears. Double click on 
the data item that you wish to 
change. 

 

 

3. Modify the value and click on 
OK. 

 

 

 

 

 

 

 

 

4. Confirm  the change by clicking 
on Yes. 

 

 

 

5. Close the multicast configuration window by clicking on OK. 

 

 

ATTENTION: The values that are modified from the multicast configuration window affect all the equipment units in the 
multicast group in the installation.  
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Default base Multicast addresses, ports and configurations 

 Broadcast address Broadcast port 

Initial configuration download 255.255.255.255 3333 

 

 Multicast address Multicast port 

Initial configuration download 239.5.5.5 8001 

 

 Multicast address Multicast port Others 

Control data 239.5.5.5 5000 Heart beat every 10 seconds 

Global audio channels 239.1.0.x 6000 + x 8 simultaneous channels  

Local audio channels 239.1.PAArea.x 6000 + (PAArea*100) + x 5 simultaneous channels  

Valid ranges (according to the IANA Guidelines for IPv4 Multicast Address) 

 Multicast address Multicast port Others 

Control data 
Between 239.0.0.0 and 
239.255.255.255 

Between 1025 and 65536 
Heart beat between 1 and 65000 
seconds. 

Global audio channels 
Between 239.0.0.0 and 
239.255.255.255 

Between 1025 and 65536 1-50 simultaneous channels  

Local audio channels 
Between 239.0.0.0 and 
239.255.255.255 

Between 1025 and 65536 1-50 simultaneous channels  

 

 

b) Notes on Local and Global Co-ordinators 

 

The system requires management of the digital audio channels at all times, so that the data may circulate freely across the network. 

This function is performed by two applications: one at a local level, known as LCC, which manages the digital channels at PA Area 
level, and another, known as GCC, which manages the digital channels at a global level (between different PA areas and/or servers). 

Each PA Area needs at least one LCC process on one of its equipment units. 

If there is more than one PA Area in an installation, and announcements have to made or music programs have to be sent between 
PA Areas, a minimum of one GCC process is required on an equipment unit in the installation. 

If the number of equipment units so permits, it is advisable to have each process available on at least two equipment units. In this 
way, the applications continue to work even when a fault in one of the equipment units occurs. 

There are specific equipment to run these applications: CC-100ETH, UMX-CC and UMX-ETH (Control). It is recommended that they 
are the ones who made the role of coordinator. If these equipment are not present in the installation, it is advisable that the COU-
02/0ETH, performs the functions of co-ordinator. 

The recommended order of priority depending on the model is as follows: 

 

 

 

 

 

 

 

CC-100ETH 
UMX-CC 

UMX-ETH 
(Control) 

COU-02/0ETH 
SU-114N 

SU-214/0N 
UP-xETH 

(Backup amplifier) 

UP-xETH 
UMX-ETH 
(program  

or priority) 

DVA-102ETH 
DC-600ETH 
FC-600ETH > > > > > 
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7.2.2. Parameters 1 tab 

(1) Language 
Configures the language in which 
the messages appear on the LCD 

screen of the DC-600ETH. 

(2) Compressor 
Activates or deactivates the 

compressor of the microphone 
desk. 

(3) Buzzer 
The desk has a buzzer which is 

activated when an alarm is 
received. This control activates or 
deactivates the buzzer. 

(4) Keypad Sound 
Activates or deactivates the sound 
of the keys (PLAY, REP, TALK and 

GONG+TALK make no sound). 

(5) Capsule Surveillance 
Activates or deactivates 

surveillance of the microphone capsule. If this 

option is activated, the system will generate an 
alarm when a fault is detected in the capsule. 

(6) Power Supply Surveillance 

Activates or deactivates surveillance of the power 
supply to the junction box of the desk. If this 
option is activated, the system detects when 

either of the two power supply inputs to the 
junction box fails, and generates an alarm. 

(7) Program Return 
Activates or deactivates the return of the 

program signal to some zones after an 
announcement has been sent from the desk to 
these zones. 

(8) Emergency mode at buttons 
If this option is enabled, the desk will go into 
emergency mode whenever the WARNING or 

EVACUATION button is pressed. 

(9) VU meter Level Indicator 
The volume bar can show the audio signal level 
when a message is sent (Only during the 

announcement) or at all times. 

(10) Rear contacts functionality 
Configures the functionality of input contacts I1, 

I2 and I3 of the desk. 

 Emergency / Warning / Evacuation. If 
this option is selected, when I1 is activated, 

the desk goes into Emergency System 
Mode; activating I2 launches the Warning 

message; and activating I3 launches the 

Evacuation message. 

 Repeat/Talk/Gong+Talk. Activates the 

Announcement System Mode functionality.   
Through this option the functions REP 
(repetition), TALK and GONG+TALK can be 
activated from contacts I1, I2 and I3 

(I1=REP, I2=TALK, I3=GONG+TALK). 

(11) Operator Control and (12) 
Administrator Control 

In order to restrict access to certain functions of 
the DC-600ETH from the controls on the front, 3 
user levels have been established: Basic, 

Operator and Administrator. 

Through these parameters, the Administrator 
password and the Operator password can be 
established. 

 Basic: Default level when the unit is switched 
on. Without password. Allows basic 
operations such as sending pre-recorded 

messages and viewing the status of the 
volume. 

 Operator: With password (by default 1234). 

In addition to all the operations available to 

the basic user, the zone volume can be 
modified. 

 Administrator: With password (by default 

1234). Without any restriction. 

(13) Emergency Mode 
Password for access to emergency mode. 

Default value 1234. 

 

(1) 

(2) 

(3) 

(5) 

(4) 

(6) 

(7) 

(8) 

(9) 

(11) 

(12) 

(13) 

(14) 

(10) 
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(14) Associated Group 

Through this option, a group can be assigned to 

the Emergency Mode, so that this group will be 
the destination of the messages when the desk 
goes into Emergency Mode. To assign a group, 

the group must first have been created by means 

of the Groups menu on the P.A. Manager 
software installations screen. 

If this parameter is left without configuration (-
None-), the emergency messages are sent to all 
the zones. 

 

 

 

7.2.3. Parameters 2 tab 

(1) Zone number  
Not used. 

(2) Mater Volume  
General volume of the desk audio. 

(3) Prerecorded Volume 

Volume of the pre-recorded 
messages of the desk. 

(4) Music Volume 

Audio volume of the music source 
connected to the desk. 

(5) Mic. Volume 

Audio volume of the desk 

microphone.  

(6) Prerecorded message - 
Source 

Configures the origin of pre-
recorded messages activated by 
the WARNING and EVACUATION 

buttons on the desk. 

 Paging Desk: Messages resident in the desk. 

 Amplifier: Messages resident in the amplifier. 
It is only possible to select Amplifier if the 

installation has UP-ETH amplifiers. 

(7) Prerecorded message - Type 
Select the type of pre-recorded messages to be 

activated by the WARNING and EVACUATION 
buttons on the desk. 

 WAV: Pre-recorded WAV messages resident 

in the Coldfire flash memory of the unit. 

 MP3: Pre-recorded MP3 messages resident in 
the MP3 circuit of the unit.  

(8) Evacuation Message 

Enter the number of the message that will be 
used as the EVACUATION message (EVACUATION 
button). 

(9) Warning Message 
Enter the number of the message that will be 
used as the pre-evacuation message (WARNING 

button). 

(10) Timeout Active Keys (minutes) 

Time length during which the last zones and/or 
messages selection is available on the 
microphone desk display. Values between 1 and 

254 minutes. Typewrite 255 to show it 
indefinitely. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Logic diagram of the volume controls 

 

(1) 

(2) (3) 

(6) 

(7) 

(8) 

(9) 

(4) (5) 

(10) 
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7.2.4. Availability tab 

By clicking on this tab, it is possible 
to restrict or enable the access of a 
desk to specific zones, groups or PA 

Areas in the installation. 

If this is not configured, the desk 
has access to all the zones in its 

own PA Area. Click on this tab if you 
wish to modify the default 
accessibility of the desk. 

(1) Enable available zones, 

groups or areas  

Tick this box if you wish to modify 
the default accessibility of the desk. 

When this option is activated, the 
desk will ONLY have access to the 
zones, groups and PA Areas that 

appear in the windows on the right. 

(2) Add and Remove buttons  

Click on these to add or delete 

access to zones, groups and PA Areas. 

From the windows on the left, select the elements to which you wish to allow messages to be sent and 
click on the button Add to add them to the list on the right. 

 

 

 

 

 

7.3. Connecting the equipment in the installation structure 

When equipment units are added to the installation, they appear in the structure with their name in red, 
preceded by the “disconnection” icon. While their status is shown as disconnected, these equipment units 
are not operative. 

To connect the equipment, proceed as follows: 

1. In the installation structure, right click with the mouse on the 
disconnected equipment unit. 

2. Click on Connect Equipment. The connection icon appears 
and the name of the equipment is shown in green. 

 

 

 

 

   =  Unit disconnected 

   =  Unit connected 

(1) 

(2) 

(2) 

(2) 
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7.4. Connection to the installation network  

1. Before connecting the desk, configure the IP address by means of the DIP switches on the underside 

of the unit (see section 5). 

2. Using the cables supplied with the desk, make the connections between the desk and the CC-600ETH 
connection box. 

3. Connect the junction box to the IP network. 

 

 

 

 

4. Connect the power supply to the connection box. 

 

 

 

7.5. Sending configurations to the desk 

Before sending configurations to any equipment unit, it is advisable to save the configuration. To do this, 
open the File menu and select Save. 

1. On the installation tree, right click with the mouse on the DC-600ETH that has just been configured 

and select the option Send configurations. 

2. A progress bar appears. Upon completion, click on OK. 

You can exit the installation screen by opening the File menu and selecting Exit. The P.A. Manager 
software will start up automatically. 

 

 

 

7.6. Editing the configured parameters  

If required, the configurations of the desk can be edited. Proceed as follows: 

1. Open the installation screen of the P.A. Manager software. 

2. In the installation structure, right click with the mouse on the name of the DC-600ETH desk whose 
configuration you wish to edit. 

3. Select Edit Equipment. 

4. The desk configuration window appears. Edit the parameters as required. 

5. Once the parameters have been configured, click on the button OK. 

6. Save the configuration by opening the File menu and selecting Save. 

7. Send the configurations to the unit (Section 7.5). 

 

 

 ATTENTION: WHEN CONNECTING THE CC-600ETH BOX TO THE IP NETWORK, ENSURE THAT THE CONNECTORS MARKED “TO 
SWITCH” ARE USED. IF THE CONNECTORS MARKED “TO OPTIMUS EQUIPMENT” ARE USED IN ERROR, THE SWITCH OR ROUTER IN THE 
INSTALLATION MAY BE DAMAGED. 
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NB: To view the page, it is 
necessary to deactivate the 
proxy in the configuration of the 
web page browser. 

8. CHANGE OF THE IP ADDRESS OF THE UNIT BY SOFTWARE 

It is possible to change the IP address of the unit by means of the DIP switches situated on the underside 
of the unit, by means of the desk configuration menus and by software. 

The software option allows 

the change to be made 
remotely, without the need 
for access to the desk. 

To make the change by 
software, from the installation 
screen of the P.A. Manager 
software right click with the 

mouse on the name of the 
unit and select the option 
Web Connection (1). 

If the PC is remote with 
respect to the installation, 
open the Internet browser 

and enter the IP of the unit in 
the address bar (for example: 
http://10.1.1.2). 
This IP address is the address 

configured by means of the IP 
ADDRESS DIP switches 
situated on the underside of 

the desk or the address 
configured from the menus of 
the desk. 

In both cases, a web page belonging to the unit will load. 

 

Proceed as follows: 

1. Enter the password in the 
Administrator Login 

section (2) (contact 
technical staff at Optimus 
and they will provide you 
with this) and click on the 

button Login. 

 

 

(1) 

(2) 

http://10.1.1.2/
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ATTENTION: 

If the IP is activated by software, the functionality of IP address selection by DIP switches will be deactivated. 

Once the change has been made, it can be undone by deleting the IP software via the web, or by selecting the address 0.0.0.0 
on the DIP switches and restarting the unit. 

 

ATTENTION: 

Once the IP address of the unit has been changed, it is necessary to modify this in the P.A. Manager software as well (see 
section 7.2.1) and send configurations to the unit (see section 7.5). 

2. Open the Expert menu (3) and click on 
the Set IP address option (4). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Write the new IP in the 
IP Address field (5) 

(for example: 
10.1.1.100) and click 
on Save IP Address 
(6). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(3) 

(4) 

(5) 

(6) 

http://192.169.1.100/


 

 
DC-600ETH version 1.4 27 

Control central and  
paging desk DC-600ETH 

 Moves the user to the 
higher level menu. 

 On the volume setting 
screen, it lowers the 
volume. 

 Selects the element 
situated to the left of 
the present selection.

 Moves the user to the next menu on the 
same level. 

 From the start screen, it shows the 
system alarms. 

 Moves the user to the previous menu on 
the same level. 

 From the start screen, it shows the busy 
zones.

 Provides access to the menu selected on 
the screen. 

 From the start screen, it provides access 
to the main menu. 

 Confirms or saves a data entry. 

 Selects the element 
situated to the right of 
the present selection. 

 On the volume setting 
screen, it increases the 
volume.

9. NAVIGATION THROUGH THE DESK MENUS 

The navigation buttons provide access to the various menus and configurations of the DC-600ETH. 

Basic menu navigation: 
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10. MENU STRUCTURE 
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In installations with a Server PC, when the DC-600ETH is restarted, this will download the configurations from the PC, so all the 
changes in configuration made from the desk keypad will be lost. 

11. OPERATIONS FROM THE DESK 

 

 

 

11.1. General operations 

 

11.1.1. User levels and changes 

To restrict access to certain functions of the desk, 
3 user levels have been established: Basic, 
Operator and Administrator. 

Basic 

Default level when the desk is switched on. 
Without password. Allows basic operations 
such as making live voice announcements, 

sending pre-recorded messages and viewing 
the status of the volume. 

Operator 

With password (by default 1234). In addition 

to all the operations available to the basic 
user, the zone volume can be modified. To 
change the password, refer to section 11.4.2. 

Administrator 
With password (by default 1234). Without any 
restriction. To change the password, refer to 

section 11.4.1. 

 

 

A. Enter as ADMINISTRATOR USER 

1. Press OK to access the main menu. 

2. Select USER and press OK. 

3. Select LOGIN ADMINISTRATOR and press 

OK. 

4. Enter the administrator user password (1 2 3 
4 by default) and press OK. 

 

B. End ADMINISTRATOR session 

1. Press OK to access the main menu. 

2. Select USER and press OK. 

3. Select LOGOUT ADMINISTRATOR and press 

OK. 

 If no key is pressed for 8 minutes, this 

operation is performed automatically. 

C. Enter as OPERATOR USER 

1. Press OK to access the main menu. 

2. Select USER and press OK. 

3. Select LOGIN OPERATOR and press OK. 

4. Enter the operator user password (1 2 3 4 by 

default) and press OK. 

 

D. End OPERATOR session 

1. Press OK to access the main menu. 

2. Select USER and press OK. 

3. Select LOGOUT OPERATOR and press OK. 

 If no key is pressed for 8 minutes, this 

operation is performed automatically. 

 

 

11.1.2. Change of menu language 

1. Press OK to access the main menu. 

2. Select ADVANCED and press OK. 

3. Select OPTIONS and press OK. 

4. Select LANGUAGE and press OK. 

5. Using the navigation keys / select a 

language and press OK. 

6. Press the navigation key  until you return to 

the start menu. 
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11.2. Basic operations in zone selection mode 

11.2.1. Sending a live paging to a zone 

1. Using the numeric keypad, enter the identifier 
number of the zone where you wish to send 
the announcement. 

 If you do not know the identifier number 
corresponding to the zone where you wish to 
send the announcement, press the  key and 

then OK. A list will appear with the name of 
each of the zones. Use the navigation keys 
/ to locate the required zone and press 

OK. 

 To delete, use the DEL key. 

2. Press and hold down GONG+TALK (or 

TALK). 

3. When the green TALK LED lights and TALK… 
appears on the screen, you can begin to 

speak. 

4. To end the announcement, release 
GONG+TALK (or TALK). 

5. Press the navigation key  to return to the 

start screen. 

 

 

11.2.2. Sending a live paging to a 
group 

1. Using the numeric keypad, press 0 and the 
identifier number of the group where you wish 

to send the announcement (groups always 
begin with the number 0). 

 If you do not know the identifier number 
corresponding to the group where you wish to 
send the announcement, press the  key and 

then OK. A list will appear with the name of 
each of the zones. Press  once again and the 

list of groups will appear. Use the navigation 
keys / to locate the required group and 

press OK. 

 To delete, use the DEL key. 

2. Press and hold down GONG+TALK (or 

TALK). 

3. When the green TALK LED lights and TALK… 
appears on the screen, you can begin to 
speak. 

4. To end the announcement, release 
GONG+TALK (or TALK). 

5. Press the navigation key  to return to the 

start screen. 

11.2.3. Sending a live paging to 

several zones and/or groups 

1. Using the numeric keypad, enter the identifier 

numbers of each of the zones or groups where 
you wish to send the announcement, 
separating each element by means of the   

key (remember that the group identifier must 
begin with 0). 

 If you do not know the identifier number 

corresponding to a zone or group where you 
wish to send the message: 

1) Press the  key and then OK. A list will 

appear with the name of each of the zones. 
Press the  key once again and the list of 
groups will appear. Using the  and  

keys, you can alternate between the list of 
groups and the list of zones. 

2) From any of the lists, use the navigation 
keys / to select the element required 

and press OK. 

 To delete, use the DEL key. 

2. Press and hold down GONG+TALK (or 
TALK). 

3. When the green TALK LED lights and TALK… 

appears on the screen, you can begin to 
speak. 

4. To end the announcement, release 

GONG+TALK (or TALK). 

5. Press the navigation key  to return to the 

start screen. 

 

11.2.4. Sending a pre-recorded general 
purpose message to zones or groups 

1. Using the numeric keypad, enter the identifier 
numbers of the zone or group where you wish 

to send the message. 

 If you do not know the identifier number 
corresponding to a zone or group, follow 

points 1) and 2) in section 11.2.3. 

 To delete, use the DEL key. 

2. Press  or  to position the cursor on the 

MP3: line and proceed to select the pre-
recorded message. 

3. Using the numeric keypad, enter the identifier 
of the message that you wish to send. To send 

several messages in a chain, enter the 
identifiers of each message, separating each 
element by means of the   key. 
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If you have configured the desk enabling the option 
Emergency mode at buttons (see section 7.2.2), 
when WARNING or EVACUATION is pressed, the desk 
automatically goes into emergency mode and plays 
the message to the emergency group, regardless of 
the zone selected. 

In zone selection mode, the messages assigned to the 
WARNING and EVACUATION buttons are not available 
when these messages are selected from the keypad. 

 If you do not know the identifier of the 
message, press OK and a list with the name 

of each message and its identifier will appear. 
Use the navigation keys / to locate the 

pre-recorded message that you require and 
press OK. 

 To delete, use the DEL key. 
 

 

 
 

 

4. Press the PLAY key. 

If you wish to stop the message before it 

ends, press the PLAY key. 

5. Once the message has ended, press the 
navigation key  to return to the start screen. 

 

11.2.5. Sending a Warning message to 
zones or groups 

1. Using the numeric keypad, enter the identifier 

numbers of the zone or group where you wish 

to send the message. 

 If you do not know the identifier number 
corresponding to a zone or group, follow 
points 1) and 2) in section 11.2.3. 

 To delete, use the DEL key. 

2. Press the WARNING key. 

 The message is repeated until the WARNING 

key is pressed once again. 

3. Press the navigation key  to return to the 

start screen. 

 

 

 

 

 

 

11.2.6. Sending an Evacuation 
message to zones or groups 

1. Using the numeric keypad, enter the identifier 

numbers of the zone or group where you wish 
to send the message. 

 If you do not know the identifier number 
corresponding to a zone or group, follow 
points 1) and 2) in section 11.2.3. 

 To delete, use the DEL key. 

2. Press the EVACUATION key. 

 The message is played indefinitely until the 
EVACUATION key is pressed once again. 

 The evacuation message takes priority over 

the warning message. If the evacuation 
message is activated while the warning 
message is being played, the warning 

message will stop. 

3. Press the navigation key  to return to the 

start screen. 

 

11.2.7. Display of busy zones 

It is possible to view a list of busy zones (the 

zones must belong to the same PA Area as the 
desk or the desk must belong to a Global PA 
Area). 

1. From the start menu, press . 

2. The list of busy zones appears. You can 
navigate through the list by means of the  

and  keys.   

 The list shows the name of the busy zone and 

the mode (priority level) of the source 
occupying that zone. 

3. Press the navigation key  to return to the 

start screen. 

 

11.2.8. Information about busy zones, 

unavailable zones and zone errors, after 
sending an announcement or message 

Once an announcement has been sent, if it has 
not been possible to broadcast this in any of the 

zones or groups selected, a list appears of the 
zones in which an incident has occurred, 
classifying the incident as follows: 

 Busy: Zones in which it has not been possible 

to play the announcement because an 
announcement of higher priority is being 
played.  

 Unavailable: The zones or groups do not 
exist or access to these zones or groups from 
the desk is restricted. 

 Zones error: Zones in which it has not been 
possible to play the announcement. 

Use the  and  keys to move from one list to 

another. 

Press OK to return to the start screen. 
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ATTENTION: 

If you have configured the desk enabling the option Emergency mode at buttons (see section 7.2.2, no.(8)), when the 
WARNING or EVACUATION button is pressed, the desk automatically goes into Emergency Mode, without the need for a 
password to be entered, and the message assigned is played. 

To exit Emergency Mode, refer to section 11.3.2. 

Access to Emergency Mode is PASSWORD protected: 1 2 3 4 (by default). 

All the messages, be they live voice or pre-recorded, will be sent to the EMERGENCY GROUP (see sections 7.2.2. (14) and 
11.4.7). 

The live voice announcement has priority over the Evacuation message, which in turn has priority over the Warning message. 

11.3. Basic operations in Emergency Mode 

 

 

11.3.1. Enter Emergency Mode 

1. Press OK to enter the main menu. 

2. Press OK once again to enter the 
EMERGENCY MODE menu. 

3. Press OK once again to enter the LOGIN 

menu. 

4. Using the numeric keypad, enter the 
emergency mode password (1234 by default) 

and press OK. The EMERGENCY MODE LED 
flashes. 

5. Press the navigation key  until you return to 

the start screen. 

 

 

11.3.2. Exit Emergency Mode 

1. Press OK to enter the main menu.  

2. Press OK once again to enter the 

EMERGENCY MODE menu. 

3. Select LOGOUT and press OK. 

4. Press the navigation key  to return to the 

start screen. 

11.3.3. Sending a live voice emergency 
announcement  

1. Press and hold down GONG+TALK (or 
TALK). 

2. When the green TALK LED lights up, begin to 
speak. When you have finished, release 
GONG+TALK (or TALK). 

 

 

11.3.4. Sending a pre-recorded 

warning message in Emergency Mode 

1. Press the WARNING key. The message 

assigned to the Warning button is 
continuously repeated. 

2. To stop it, press the WARNING key once 
again. 

 

 

11.3.5. Sending a pre-recorded 

evacuation message in Emergency 
Mode 

1. Press the EVACUATION key. The message 
assigned to the Evacuation button is 

continuously repeated. 

2. To stop it, press the EVACUATION key once 
again. 
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Remember that in installations with a Server PC, when the DC-600ETH is restarted, this will download the configurations from 
the PC, so all the changes in configuration made from the desk keypad will be lost. 

11.4. Advanced operations 

 

 

 

 

 

11.4.1. Changing the ADMINISTRATOR 
password  

(Requires Administrator user level). 

1. Press OK to access the main menu. 

2. Select ADVANCED and press OK. 

3. Select OPTIONS and press OK. 

4. Select CHANGE CODE ADMINISTRATOR 
and press OK. 

5. Enter the new administrator password and 
press OK. 

6. Repeat the new password and press OK. 

 

 

11.4.2. Changing the OPERATOR 

password  

(Requires Administrator user level). 

1. Press OK to access the main menu. 

2. Select ADVANCED and press OK. 

3. Select OPTIONS and press OK. 

4. Select CHANGE CODE OPERATOR and press 
OK. 

5. Enter the new operator password and press 

OK. 

6. Repeat the new password and press OK. 

 

 

11.4.3. Modifying the volume of a zone 

(Requires Administrator user level) 

Only the volume of zones that correspond to 

digital amplifiers can be modified. 

1. Press OK to access the main menu. 

2. Select VOLUMES and press OK. 

3. Use the navigation keys / to locate the 

zone where you wish to modify the volume 
and press OK. 

4. Using the navigation keys /, select the 

volume channel that you wish to modify 

(LOCAL PROGRAM, LOCAL PRIORITY, ETH 
PROGRAM and ETH PRIORITY). 

5. Modify the volume of the option selected by 
means of the navigation keys /. 

6. Save the volume configuration by pressing the 
OK key or reject the changes by pressing 
DEL. 

 The data with respect to the volume 
established are saved in the digital amplifier of 
the corresponding zone and in the Server PC, 

so the volume level established is maintained 
although the unit may be restarted. 

7. Press the navigation key  to return to the 

start screen. 

 

 

11.4.4. Monitoring pre-recorded MP3 

messages 

(Requires Administrator user level). 

NB: This functionality is not available when the desk is 
sending a music program. 

1. Press OK to access the main menu. 

2. Select MONITOR MP3 and press OK. 

3. Use the navigation keys / to locate the 

message that you wish to monitor. 

4. Press OK to begin monitoring. 

5. If you wish to stop the message, press OK 

once again. 

6. Press the navigation key  to return to the 

start screen. 
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ATTENTION: 

The messages from the desk assigned to the WARNING 
or EVACUATION buttons cannot be used as general 
purpose messages. 

11.4.5. Configuring the origin of the 

WARNING and EVACUATION messages 

(Requires Administrator user level). 

The WARNING and EVACUATION messages can 
be stored in the DC-600ETH desk or in the power 

units of the OPTIMAX series. 

If the desk is configured to store these 
messages, when they are activated, they are 

sent through the Ethernet connection to the 
emergency group zones. If, on the other hand, 
the configuration is such that the amplifiers 
contain these messages, when they are 

activated, the desk sends the order to the 
amplifiers to play the message. 

1. Press OK to access the main menu. 

2. Select ADVANCED and press OK. 

3. Select MESSAGES and press OK. 

4. Select MESSAGES SOURCE and press OK. 

5. Using the navigation keys /, select the 

origin of the WARNING and EVACUATION 
messages: PAGING DESK or ZONE. 

6. Press OK. 

7. Press the navigation key  to return to the 

start screen. 

 
 

11.4.6. Configuring the WARNING and 

EVACUATION button messages 

(Requires Administrator user level). 

Both the desks and the amplifiers in the OPTIMAX 
series have two internal memories in which files 

can be stored for subsequent use as pre-recorded 
messages: 

 MP3 circuit memory, for files in MP3 format 

 Coldfire flash memory, for files in WAV format. 

This configuration establishes which memory the 
desk is to access in order to search for the 

evacuation or warning message, and what the 
content of each of these messages is. 

1. Press OK to access the main menu. 

2. Select ADVANCED and press OK. 

3. Select MESSAGES and press OK. 

4. Select WARNING PUSH-BUTTON MESSAGE 
or  EVACUATION PUSH-BUTTON MESSAGE. 

5. Use the navigation keys / to select the 

type of message that you wish to assign (MP3 
or WAV) and press OK. 

6. Use the navigation keys / to locate the 

message that you wish to assign and press 
OK. 

7. Press the navigation key  to return to the 

start screen. 

NB: If this option is not configured and there are 
messages in the memory, message 1 in the MP3 

memory of the desk is automatically assigned to 
the EVACUATION button and message 2 in the 
MP3 memory of the desk is assigned to the 

WARNING button. 

 
 

 

11.4.7. Assigning the Emergency 

Group 

(Requires Administrator user level). 

This group will be the destination of the 

messages whenever the desk goes into 
Emergency Mode. To assign a group, the group 
must first have been created by means of the 

Group menu on the P.A. Manager software 
installations screen. 

If this is left unconfigured, the emergency 

messages are sent to all the zones. 

To configure this, proceed as follows: 

1. Press OK to enter the main menu. 

2. Press OK once again to enter the 

EMERGENCY MODE menu. 

3. Select EMERGENCY GROUP and press OK. 

4. Use the navigation keys / to select the 

group that you wish to assign and press OK. 

5. Press the navigation key  to return to the 

start screen. 
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  Alarm generated by the desk itself 

  System alarm 

11.4.8.  Updating the MP3 memory 

(Requires Administrator user level). 

Whenever files are recorded in or deleted from 

the MP3 memory of the desk, it is necessary to 
update the memory. 

1. Press OK to access the main menu. 

2. Select ADVANCED and press OK. 

3. Select OPTIONS and press OK. 

4. Select MP3 PLAYER and press OK. 

5. Select MEMORY UPDATE and press OK. 

6. Press the navigation key  to return to the 
start screen. 

 

 

11.4.9. Formatting the MP3 memory 

 (Requires Administrator user level). 

ATTENTION: This action deletes all files 

from the MP3 memory of the desk. 

1. Press OK to access the main menu. 

2. Select ADVANCED and press OK. 

3. Select OPTIONS and press OK. 

4. Select MP3 PLAYER and press OK. 

5. Select FORMAT and press OK. 

6. Press the navigation key  to return to the 
start screen. 

 

11.4.10. Changing the IP address of the 

desk by means of the keypad 

(Requires Administrator user level). 

1. Press OK to access the main menu. 

2. Select ADVANCED and press OK. 

3. Select IP ADDRESS (X.X.X.X) and press OK. 

4. Use the numeric keypad to enter the IP 
address, separating each octet by means of 
the   key. 

5. Press OK to save the IP address. 

6. Press the navigation key  to return to the 
start screen. 

 
 

11.4.11. Re-establishing the IP address 
on the desk by DIP switch 

(Requires Administrator user level). 

1. Disconnect the power supply to the desk. 

2. Remove the panel from the underside of the 

desk and compose the IP ADDRESS 0.0.0.0 by 
means of the DIP switches. 

3. Reconnect the power supply to the desk. 

4. Once the desk has started up, turn it off 
again. 

5. Compose the IP address required by means of 

the bottom DIP switches. Put the panel back 
on and turn the desk on.

 

 

12. SYSTEM ALARMS 
 

The desk has several alarm systems which indicate that a fault has occurred in an element of the PA 
system. 

 Information on the LCD screen: On-screen display of icons indicating an alarm and information about 

the alarm. 

 Alarm light indicator: Red LED on the front panel of the desk. 

 Alarm acoustic indicator: Intermittent beep. 

 

 

12.1. Alarms on the LCD screen of the desk 

The appearance of alarm icons on the screen of the desk 

indicates that the desk is receiving one or several alarms 
from the system, or the desk itself is generating an alarm. 

These icons are visible on any of the desk menus. 
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The number that appears next to each alarm indicates 
the number of alarms that exist of each type (alarms 

generated by the desk and system alarms). 

To view each of the alarms in detail: 

1. From the start screen, press . 

2. Use the navigation keys / to view each of the 

alarms. 

 The name of the unit causing the alarm appears on 
the top line and the category of alarm appears on the 
bottom line. In the case of alarms generated by the desk itself, “(INTERNAL MIC.)” appears instead of 
the name. 

3. Press the navigation key  to return to the start screen. 

 

ATTENTION: Depending on the configuration of the P.A. Manager software, some of the alarms may not 
appear on the list (Installations Screen, menu Options>Alarm Management). 

 

 

12.2. Alarm acoustic indicator (buzzer) 

The desk has a buzzer which sounds whenever an alarm is received. The acoustic indication, a beep 
lasting 0.5 seconds, is repeated every 5 seconds until the alarm is accepted (see section 12.2.1). 

 

12.2.1. Acceptance of an alarm 

Reception of an alarm activates the acoustic 

indicator. When an alarm is accepted, the 
acoustic indicator for that alarm stops (if there 
are more unaccepted alarms, the acoustic 
indicator will remain activated). 

To accept an alarm: 

1. Press  to access the list of alarms. 

2. Use the navigation keys / to view the 

alarm that you wish to accept. 

3. Press OK. When the alarm is accepted, the 

validation symbol appears. 

4. Press the navigation key  to return to the 

start screen. 

12.2.2. Activation or deactivation of 
the acoustic indicator 

(Requires Administrator user level). 

The acoustic indicator can be activated or 
deactivated. If it is deactivated, the alarm 
acoustic indicator stops operating. 

Press OK to access the main menu. 

1. Select ADVANCED and press OK. 

2. Select OPTIONS and press OK. 

3. Select BUZZER and press OK. 

Select ACTIVATE or DEACTIVATE and press OK 
to save. 

 

 

12.3. Alarm light indicator 

This lights when the desk receives one or several system alarms, or when it generates an alarm itself. 

Acceptance of the alarms does not turn the ALARM LED off. 

 
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12.4. List of alarms 
 

IP DISCONNECTION Occurs when a unit loses the Ethernet connection. 

DSP FAIL Error in the DSP of the unit 

SPI(n) FAIL Internal hardware error in the unit 

LINK A FAIL Unit without Ethernet connection in port A 

LINK B FAIL Unit without Ethernet connection in port B 

POWER SUPPLY A FAIL 

In OPTIMAX power units with dual power supply (230 V AC mains supply and 24 V 
DC battery supply), failure of the 230 V AC power supply.  

In DC-600ETH or FC-600ETH desks, failure of power supply A (24 V DC). 

POWER SUPPLY B FAIL 

In OPTIMAX power units with dual power supply (230 V AC mains supply and 24 V 
DC battery supply), failure of the 24 V DC battery supply.  

In DC-600ETH or FC-600ETH desks, failure of power supply B (24 V DC). 

ANM SENSOR FAIL 
Failure of RS485 communication between the OPTIMAX power unit and the NS-485 
noise sensor. 

DIF TEMP SENSORS>20 
There is a difference in temperature of more than 20 °C between the values read by 
the internal temperature sensors of the amplifier. 

TEMPERATURE ALARM 
The temperature of the amplifier is higher than the temperature set by 
configuration. 

LINE FAIL – HIGH 
Appears if a high impedance error occurs in Optimax amplifiers whose line 
surveillance is activated. 

LINE FAIL – LOW 
Appears if a low impedance error occurs in Optimax amplifiers whose line 
surveillance is activated. 

EMERG. LINK FAIL 
Appears if the emergency input connection fails on Optimax amplifiers with 
emergency input surveillance activated. 

EVAC. CONTACT FAIL 
Appears if the connection of the contact activating the emergency input evacuation 
message fails. Only on Optimax amplifiers with surveillance of emergency input 
contacts activated. 

WARNING CONTACT FAIL 
Appears if the connection of the contact activating the emergency input pre-
evacuation message fails. Only on Optimax amplifiers with surveillance of 
emergency input contacts activated. 

EMERG. CONTACT FAIL 
Appears if the connection of the priority contact of the emergency input of the 
amplifier fails. Only on Optimax amplifiers with surveillance of emergency input 
contacts activated. 

PROTECTION ALARM Protection of the amplifier is activated. 

MP3 FILE FAIL 
Possible corruption of the data corresponding to the MP3 file in the OPTIMAX 
power unit memory.  

FRONT SENSOR FAIL 
The internal temperature sensor at the front of the OPTIMAX amplifier is not 
communicating correctly. 

REAR SENSOR FAIL 
The internal temperature sensor at the rear of the OPTIMAX amplifier is not 
communicating correctly. 

CAPSULE FAIL – HIGH Detection of open line in the capsule of a DC-600ETH or FC-600ETH desk. 



 

 
DC-600ETH version 1.4 39 

Control central and  
paging desk DC-600ETH 

13. DIMENSIONS 

 

 

 

14. TECHNICAL SPECIFICATIONS 
DC-600ETH 

Inputs 2 Ethernet and 1 music program input (RCA connectors) 

Power supply 24 V DC 

Consumption 500 mA 

Weight Desk + junction box + accessories: 2.7 kg 

Finishing 

Desk: Plastic Bayblend RAL7021 

Front polyester adhesive Pantone 447C 
Junction box: Black skinplate 

 

MICROPHONE 

Capsule Dynamic 

Polar diagram Unidirectional 

Frequency response 150 Hz 8 kHz 

Sensitivity -76dB  3 dB (0 dB = 1 V/microbar at 10,000 Hz) 

Output impedance 500 Ohm  30% (at 1 kHz) 

Finishing Aluminium 
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15. NETWORK SPECIFICATIONS 

The Optimax PA system supports audio and control data communication through Ethernet and IP 
networks. Since it works on levels 3 and 4 of the OSI scale, the Optimax protocol supports 
communication through routers (IP protocol) by means of the configurations of the gateways and 

subnetwork masks. Thanks to these features, Optimax can work on both LANs and WANs. 

Most of the communications in the Optimax systems use multicast. Multicast is an effective means of 
providing transit services from one sender to many receivers. It is absolutely essential to exhaustively 

and rigorously check the network configuration in order to ensure that the system operates correctly. 

The multicast networks include a wide range of protocols, from filter protocols (IGMP, MLD) to routing 
protocols (MOSPF, DVMRP, PIM-DM and PIM-SM/SSM). 

Optimax incorporates an application-level control (ACK) (level 7 of the OSI scale) of the management 

data sent. 

 

1. Default multicast base addresses, ports and configurations 

 Dirección Broadcast Puerto Broadcast 

Initial configuration download 255.255.255.255 3333 

 

 Dirección Multicast Puerto Multicast 

Initial configuration download 239.5.5.5 8001 

 

 Multicast address Multicast port Others 

Control data 239.5.5.5 5000 Heart beat every 10 seconds 

Global audio channels 239.1.0.x 6000 + x 8 simultaneous channels  

Local audio channels 239.1.PAArea.x 6000 + (PAArea*100) + x 5 simultaneous channels  

2. Valid ranges (according to the IANA Guidelines for IPv4 Multicast Address) 

 Multicast address Multicast port Others 

Control data 
Between 239.0.0.0 and 
239.255.255.255 

Between 1025 and 65536 
Heart beat between 1 and 65000 
seconds. 

Global audio channels 
Between 239.0.0.0 and 
239.255.255.255 

Between 1025 and 65536 1-50 simultaneous channels  

Local audio channels 
Between 239.0.0.0 and 
239.255.255.255 

Between 1025 and 65536 1-50 simultaneous channels  

 
3. Local network (LAN) specifications 

- Dedicated VLAN 

- Bandwidth: 4 Mb for each audio channel. 

- Number of audio channels:  

 Up to 50 global channels (from the exchange to the satellites) 

 Up to 50 local channels (internal to the satellite, they do not consume backbone bandwidth) 
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(*) Multicast addresses and reserved ports 

4. Switch/router specifications for LAN and 
WAN networks 

- Protocols: 

 UDP/ IP multicast for Audio. 

 UDP/ IP multicast for Control. Security of 

reception by means of ACK management 
protocol in Application Layer. 

- Multicast snooping: 

 Multicast filtering 

 IGMP v2 

- For large installations: 

 Multicast routing (Spanning Tree) 

 Capacity to handle TOS (Type Of Service) 

 

 

 

5. Certified hardware 

- Large installations: 

 Nortel: BayStack 470, Ethernet Routing 
Switch 3510 and higher 

 Cisco: 36XX or higher 

 Alcatel: Level 3 switches 

 

- Medium-sized installations: 

 NKF: XSNET 1800 

 Hirschmann: RS30-0802O6O6SDAEHH01.0 

 

- Small installations, with a proprietary 

network: 

 Nortel: BayStack 425 

 Cisco: 500G and 29600 families 

 Equitel: N950 

 

 

6. Network protocol stack 
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16. SOFTWARE AND FIRMWARE VERSIONS 

The functionalities described in this user’s manual are valid for the following software and firmware 
versions (or later versions): 

DC-600ETH Firmware  Image (Operating System)  2.4  

Coldfire Application   2.6.13 

P.A. Manager Software  Version 2.6 / Revision 3995.26517 

Optimus Flasher Software  Version 2.6.7 

 

17. DOCUMENT VERSION TRACKING 

Reference system Type of Document  Confidentiality N/A 

Optimax Installation and operation guide 

 

Rev Date Modifications Content Written by: 

1.0 September 06 First version R&D Department 

1.1 October 07 

The following sections are added: 

7. MENU STRUCTURE 

8. OPERATIONS  

10. DIMENSIONS 

R&D Department 

1.2 September 08 Pagination and spelling corrections R&D Department 

1.3 November 09 

The following sections are added or modified: 

1. INTRODUCTION 

2. FRONT VIEW 

3. REAR VIEW 

4. CONNECTIONS 

5. SETTINGS AND CONFIGURATION 

6. PRE-RECORDED MESSAGES 

7. STARTING UP THE DESK 

8.  CHANGE OF THE IP ADDRESS OF THE UNIT BY SOFTWARE 

9. NAVIGATION THROUGH THE DESK MENUS 

10. MENU STRUCTURE 

11. OPERATIONS FROM THE DESK 

12. SYSTEM ALARMS 

15. NETWORK SPECIFICATIONS 

16. SOFTWARE AND FIRMWARE VERSIONS 

17. DOCUMENT VERSION TRACKING 

R&D Department  

 

1.4 December 10 

7.2.1. General tab. Multicast addresses and valid ranges 

7.2.3. Parameters 2 tab 

15. NETWORK SPECIFICATIONS 

16. SOFTWARE AND FIRMWARE VERSIONS 

R+D Department 
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18. GUARANTEE 

 

1. GUARANTEE CERTIFICATE 

1. OPTIMUS S.A. guarantees that its products are free from material and 

manufacturing defects when they are first delivered to the purchaser. 

2. In accordance with the conditions outlined here, OPTIMUS S.A. 

guarantees its products for two (2) years from the date on which the 
purchaser acquires the product. If, within this guarantee period, defects 

appear which are not due to factors outlined in section 2, OPTIMUS S.A. 

shall replace or repair the unit using equivalent, new or reconstructed 
replacement parts, as it deems fit. If replacement parts are applied which 

improve the unit, OPTIMUS S.A. reserves the right to charge the client for 
the additional cost of these components. 

3. No guarantee benefits shall be provided other than those cited here. 

4. In order to claim the guarantee rights, it shall be an essential 

requirement to present the original purchase invoice or the guarantee 
certificate. 

2. GUARANTEE PROVISIONS 

1. In the event that the product had to be modified or adapted to comply 

with local requirements concerning technical specifications or safety, and if 
the country in question is not the country for which the product was 

originally designed and manufactured, defects are not considered to be 
material or manufacturing defects. Furthermore, the guarantee does not 

cover the execution of these modifications or adaptations, regardless of 

whether or not they have been carried out correctly. 

Nor shall OPTIMUS S.A. be responsible for any costs under this guarantee 

for these types of modifications. 

2. The guarantee shall not entitle the purchaser to inspection or free 

maintenance or repair of the unit, particularly if the defects are due to 
inappropriate use. Nor do the guarantee rights cover defects in wearing 

parts that become worn as a result of normal wear and tear. Wearing parts 
are, in particular, potentiometers, switches/keys, and similar parts. 

3. The guarantee does not cover defects in the equipment unit caused by: 

 Abuse or incorrect use of the unit for purposes other than those for 

which it is intended, in non-compliance with the service and 
maintenance instructions specified in the Manual and/or Technical 

Instructions for the unit. 

 Connection or use of the product in a manner that does not correspond 

to the technical or safety requirements of the country in which the unit 

is used. 

 Installation in conditions other than those indicated in the Manual 

and/or Technical Instructions. 

 Deficiency or interruptions in the electricity supply or installation 

defects which imply use in abnormal conditions. 

 Damage caused by other equipment units that are connected to the 

product. 

 The use or installation of Software (programmes), interfaces, parts or 

supplies not provided and/or not authorised by OPTIMUS S.A. 

 Failure to use the original packaging for transportation. 

 Damage caused by force majeure or other causes not attributable to 
OPTIMUS S.A. 

4. The following elements are not covered by this guarantee: 

 All plastic surfaces and all parts exposed to outdoor conditions which 

have been scratched or damaged as a result of normal or abnormal 

use. 

 Breakages, knocks, damage due to a fall or scratches caused by 

moving the unit in any way. 

 Damage caused by tests, use, maintenance, installation or 

inappropriate adjustments, or as a result of any alteration or 
modification of any kind not carried out by a Service Authorised by 

OPTIMUS S.A. in compliance with this guarantee. 

 Damage to persons or property that might be caused by the improper 

use of the equipment, including lack of maintenance. 

5. The guarantee shall not be valid whenever the following is observed: 

 Amendments or corrections made to the details of the guarantee 
certificate or purchase invoice. 

 Failure to produce the original invoice or the absence of a date on this. 

 Absence of the serial or batch number on the equipment. 

6. In the case of personal computers, the guarantee will not cover the 
elimination of computer viruses, the restoration of programmes damaged 

by these or the reinstallation of the disk following its deletion. 

7. The rights of this guarantee are invalidated if the product has been 

repaired or opened by staff unauthorised by OPTIMUS S.A. or by the client 
himself. 

8. If OPTIMUS S.A. were to establish before the client that the damage 
affecting the unit does not entitle a claim to be made under the guarantee, 

the costs of checking the equipment incurred by OPTIMUS S.A. shall be 
borne by the client. 

9. Products not covered by the guarantee shall only be repaired once 

payment has been effected by the client. In the event that the guarantee 
rights do not apply, OPTIMUS S.A. shall duly inform the client. If, within a 

period of 6 weeks from this communication, no written repair order is 
received from the client confirming acceptance of the costs, OPTIMUS S.A. 

shall return the unit in question to the client. In this case, the transport and 
packaging costs shall be invoiced separately and payment shall be made on 

delivery. In the event that a repair order is sent by the client, confirming 
that he assumes the costs of repair, the transport and packaging costs shall 

be invoiced additionally, and also separately. 

10. If the equipment needs to be transferred to the Authorised Service 

Centre, transportation shall be effected by the responsible party according 
to the guarantee, who will also bear the freight and insurance costs. 

11. In the event of a defect, OPTIMUS S.A. guarantees that the repair 
and/or replacement of parts so that the unit operates correctly will be made 

within a period of no more than 30 days. Nevertheless, OPTIMUS S.A. 

would like to clarify that the normal period does not exceed 30 days. 

12. All parts or products replaced as part of the guarantee services shall 

become the property of OPTIMUS S.A. 

3. TRANSFER OF GUARANTEE  

The guarantee is solely awarded to the original purchaser (principal client) 
and is not transferable. With the exception of OPTIMUS S.A., no third party 

(dealers, etc.) is authorised to award additional guarantees on behalf of 
OPTIMUS S.A. 

4. CLAIMS FOR DAMAGE 

In the event that OPTIMUS  S.A. cannot provide a suitable guarantee 

service,  the purchaser shall not be entitled to claim any indemnity for 
damages arising. The responsibility held by OPTIMUS S.A. is limited in all 

cases to the invoicing price of the product. 

5. RELATION WITH OTHER GUARANTEE RIGHTS AND NATIONAL 

LAW 

1. This guarantee does not affect the rights of the purchaser with respect to 
the vendor arising from the contract of sale accomplished. 

2. These conditions of the guarantee provided by OPTIMUS S.A. are valid as 
long as they do not contradict the corresponding national law on guarantee 

provisions. 

3. OPTIMUS S.A. guarantees that this product complies with the safety 

regulations in force in the country. 

 

THIS LIMITED GUARANTEE DECLARATION IS THE EXCLUSIVE GUARANTEE 
OFFERED BY OPTIMUS  S.A.  ALL OTHER EXPLICIT OR IMPLICIT 

GUARANTEES ARE EXCLUDED, AND THIS ALSO APPLIES TO GUARANTEES 
OF MARKETABILITY AND SUITABILITY FOR A PARTICULAR PURPOSE. 

(EXCEPT WHEN THESE GUARANTEES ARE REQUIRED BY AN APPLICABLE 
LAW). NO GUARANTEE, EITHER EXPLICIT OR IMPLICIT, SHALL BE APPLIED 

ONCE THE GUARANTEE PERIOD HAS EXPIRED 

 

 

 

 

OPTIMUS S.A. 

After-Sales Service  

C/ Barcelona 101 

17003 - GIRONA 

Tel. 902 151 96  /  972 203 300  

Fax. 972 21 84 13 

e-mail:girona@optimus.es 9/44/CE1999/44/CE 

 



 

 

 

 

 

 

 


